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http://thegrantlab.org/bimm143

Find-a-Gene Project Assignment

» A total of 20% of the course grade will be assigned based on the
“find-a-gene project assignment”

* The objective with this assignment is for you to demonstrate your
grasp of database searching, sequence analysis, structure analysis
and the R environment that we have covered to date in class.

* You may wish to consult the scoring rubric (in the linked project
description) and the example report for format and content
guidance.

= Your responses to questions Q1-Q4 are due at the beginning of
class Thursday Nov 14th (11/14/19).

= The complete assignment, including responses to all guestions,
is due at the beginning of class Thursday Dec 3rd (12/03/19).


https://bioboot.github.io/bimm143_F19/class-material/Find_A_Gene_Project.pdf
https://bioboot.github.io/bimm143_F19/class-material/Find_A_Gene_Project_Example.pdf

Questions:

[Q1] Tell me the name of a protein you are interested in. Include the species and the accession
number. This can be a human protein or a protein from any other species as long as it's function
is known.

If you do not have a favorite protein, select human RBP4 or KIF11. Do not use beta globin as
this is in the worked example report that | provide you with online.

[Q2] Perform a BLAST search against a DNA database, such as a database consisting of
genomic DNA or ESTs. The BLAST server can be at NCBI or elsewhere. Include details of the
BLAST method used, database searched and any limits applied (e.g. Organism).

Also include the output of that BLAST search in your document. If appropriate, change the font
to courier size 10 so that the results are displayed neatly. You can also screen capture a
BLAST output (e.g. alt print screen on a PC or on a MAC press #-shift-4. The pointer becomes
a bulls eye. Select the area you wish to capture and release. The image is saved as a file called
Screen Shot [].png inyour Desktop directory). It is not necessary to print out all of the
blast results if there are many pages.

On the BLAST results, clearly indicate a match that represents a protein sequence,
encoded from some DNA sequence, that is homologous to your query protein. | need to
be able to inspect the pairwise alignment you have selected, including the E value and
score. It should be labeled a "genomic clone" or "mRNA sequence", etc. - but include no
functional annotation.

In general, [Q2] is the most difficult for students because it requires you to have a “feel”
for how to interpret BLAST results. You need to distinguish between a perfect match to

your query (i.e. a sequence that is not “novel”), a near match (something that might be

“novel”, depending on the results of [Q4]), and a non-homologous result.

If you are having trouble finding a novel gene try restricting your search to an organism
that is poorly annotated.

[@3] Gather information about this “novel” protein. At a minimum, show me the protein
sequence of the “novel” protein as displayed in your BLAST results from [Q2] as FASTA
format (you can copy and paste the aligned sequence subject lines from your BLAST
result page if necessary) or translate your novel DNA sequence using a tool called
EMBOSS Transeq at the EBI. Don’t forget to translate all six reading frames; the ORF
(open reading frame) is likely to be the longest sequence without a stop codon. It may
not start with a methionine if you don’t have the complete coding region. Make sure the
sequence you provide includes a header/subject line and is in traditional FASTA format.

Here, tell me the name of the novel protein, and the species from which it derives. It is
very unlikely (but still definitely possible) that you will find a novel gene from an
organism such as S. cerevisiae, human or mouse, because those genomes have
already been thoroughly annotated. It is more likely that you will discover a new gene in
a genome that is currently being sequenced, such as bacteria or plants or protozoa.

[Q4] Prove that this gene, and its corresponding protein, are novel. For the purposes of
this project, “novel” is defined as follows. Take the protein sequence (your answer to
[Q3]), and use it as a query in a blastp search of the nr database at NCBI.

+ If there is a match with 100% amino acid identity to a protein in the database, from the
same species, then your protein is NOT novel (even if the match is to a protein with a
name such as “unknown”). Someone has already found and annotated this sequence,
and assigned it an accession number.

+ If the top match reported has less than 100% identity, then it is likely that your protein
is novel, and you have succeeded.

« If there is a match with 100% identity, but to a different species than the one you
started with, then you have likely succeeded in finding a novel gene.

+ If there are no database matches to the original query from [Q1], this indicates that
you have partially succeeded: yes, you may have found a new gene, but no, it is not
actually homologous to the original query. You should probably start over.

[Q5] Generate a multiple sequence alignment with your novel protein, your original
query protein, and a group of other members of this family from different species. A
typical number of proteins to use in a multiple sequence alignment for this assignment
purpose is a minimum of 5 and a maximum of 20 - although the exact number is up to
you. Include the multiple sequence alignment in your report. Use Courier font with a size
appropriate to fit page width.

Side-note: Indicate your sequence in the alignment by choosing an appropriate name
for each sequence in the input unaligned sequence file (i.e. edit the sequence file so
that the species, or short common, names (rather than accession numbers) display in
the output alignment and in the subsequent answers below). The goal in this step is to
create an interesting an alignment for building a phylogenetic tree that illustrates
species divergence.






What is Git?

(1) An unpleasant or contemptible
person. Often incompetent,
annoying, senile, elderly or
childish in character.

(2) A modern distributed version ®
control system with an emphasis 0 glt

on speed and data integrity.
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Version Control

Version control systems (VCS) record changes
to a file or set of files over time so that you can
recall specific versions later.

Free/open-source CVS (1986, 1990 in C) - CVSNT (1998) - QVCS Enterprise (1998) « Subversion (2000)

Software Change Manager (1970s) - Panvalet (1970s) - Endevor (1980s) - Dimensions CM
Client-server (1980s) - DSEE (1984) - Synergy (1990) « ClearCase (1992) - CMVC (1994) - Visual SourceSafe
Proprietary (1994) - Perforce (1995) - StarTeam (1995) - Integrity (2001) + Surround SCM (2002) -

AccuRev SCM (2002) - SourceAnywhere (2003) « Vault (2003) - Team Foundation Server (2005)
Team Concert (2008)

Free/open-source GNU arch (2001) - Darcs (2002) - DCVS (2002) « ArX (2003) - Monotone (2003) «+ SVK (2003) -
Distributed Codeville (2005) - Bazaar (2005) « Git (2005) - Mercurial (2005) « Fossil (2007) + Veracity (2010)

Proprietary TeamWare (1990s?) - Code Co-op (1997) - BitKeeper (1998) - Plastic SCM (2006)

There are many VCS available, see:
https://en.wikipedia.org/wiki/Revision control



https://en.wikipedia.org/wiki/Revision_control

Client-Server vs Distributed VCS

Client-server approach Distributed approach

Distributed version control systems (
multiple people to work on a given p
requiring them to share a commo

DCVS) allows
roject without

N network.



THE #1 PROGRAMMER EXCUSE
FOR LEGITIMATELY SLACKING OFF:

“The Subversion server’s down”
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http://tinyurl.com/distributed-advantages

Git is now the most popular free VCS!

THE #1 PROGRAMMER EXCUSE
FOR LEGITIMATELY SLACKING OFF:

“The Subversion server’s down” Git offers:
_ _\ ¢ Speed
e
(HEY! GETBACK Y .
\_TOWORK! 3ackups

" “. e Off-line access
| o Small footprint

R e Simplicity*
m‘ e Social coding

- @1 SVNsdowV

OH. CARRY ON.

http://tinyurl.com/distributed-advantages


http://tinyurl.com/distributed-advantages

Where did Git come from?

Written Initially by Linus Torvalds to
support Linux kernel and OS
development.

Meant to be distributed, fast and
more natural.

Capable of handling large projects.

Now the most popular free VCS!




Why use Git?



Q. Would you wrikte your Lab boole tn
pencil, then erase and overwrite it
every daj wikth new conbenk?



Q. Would you, wrike your Lab boole in
pencil, then erase and overwrite it
every d&j wikth new conkenk?

Version control is the lab notebook of the digital
world: it's what professionals use to keep track of
what they've done and to collaborate with others.



Why use Git?

Provides ‘snapshots’ of your project during development
and provides a tull record of project history.

Allows you to easily reproduce and rollback to past
versions of analysis and compare differences. (N.B. Helps
fix software regression bugs!)

Keeps track of changes to code you use from others such
as fixed bugs & new features

Provides a mechanism for sharing, updating and
collaborating (like a social network)

Helps keep your work and software organized and available



Obtaining Git



. Note: You might already have git installed
To check open the “Terminal” tab in RStudio and type

@ which git
() git --version

Obtaining Git




: Note: You might already have git installed ;
: To check open the “Terminal” tab in RStudio and type: :

@ which git
@ git --version

: Windows
Follow the GitBash instructions here:

: https://bicboot.github.io/bimm143 S19/setug[

. Mac & Linux
: Download git directly from here:

: https://git-scm.com/downloads




Configuring Git



Configuring Git

(RStudio Terminal Tab)
(...or RStudio > Tools > Shell)

# First tell Git who you are
> git config --global user.name “Barry Grant”
> git contig --global user.email "bjgrant@Qucsd.edu”



Using Git



Using Git

1. Initiate a Git repository,
2. EAit content (Le. change some files).
3. Store a ‘snapshot’ of the current file state.x



For Mac & Linux
(PC on next slide)

Go to: RStudio > Tools > Global Options > Git/SVN

Options

¥ Enable version control interface for RStudio projects 1 Ma ke Sure l‘h /S /S tiCked/

Git executable:

) o 2 Make sure this is correct!

SVN executable:

Jusr/bin/svn

SSH RSA Key:
Console Terminal R Markdown

? Using Version Control with RStudio

~ © Terminal ¥~ another

blitz:anqxt
/usr/local/bin/git
blitz:another>

Spelling

Git/SVN




On a PC!

Go to: RStudio > Tools > Global Options > Git/SVN

Options

coreral v|Enable version control interface for RStudio projects 1 M a ke Sure l‘h /S /S ticked /
2 This is the PATH for PC!

Appearance SVN executable:

Pane Layout //Mac/Home/Documents Browse...

Packages SSH RSA Key:

Z

R Markdown

= | bin
Create RSA Key...

) Sweave Home Share View

?’ Using Version Control with RStudio
ABC

. This PC > Local Disk (C:) 2 Program Files > Git > bin
v Spelling

A

5 Documents Name Date modified

W Git/suN

= Pictures B bash

iCloud Drive ( B git

8, publishing

. Terminal

Dropbox (Mac B sh

m Desktop




Create a new
RStudio project

1 New option to create
a Git repository... 2 New Gittab. ..

AW

Create New Project Environment  History  Connections  Git_ ™

Directory name: : . Diff Commit | | 0 | b b :
4 L, - Staged Status Path
| 8 Create project as subdirectory of: e
: gitignor
e rowse... . . . gitignore

™ B B test.Rproj

¥l Create a git repository

|_lUse packrat with this project

Check if new Git options appear in RStudio?



GitHub & Bitbucket

GitHub and Bitbucket are two popular hosting services for
Git repositories. These services allow you to share your
projects and collaborate with others using both ‘public’ and
‘private’ repositories™.

Pull requests Issues Gist A = ©Bitbucket Dashboard - Teams - Repositories ~  Snippets ~ Create ~ Findarepository... @ @ 9 N

Dashboard
Overview Pull requests Issues (2 Snippets

All Watching Mine Teams i
New to Git?

& Grantlab / bio3d

Create repositories Fork repositories Work together
1 . sa e Learn more

hel or’ te ne\ nique o ull requ follo

%y larsss / cheminf
one B

ithub.com s://bitbucket.org ...

2d1 Merge branch 'gh-pages’ of h hub.co Your repositories

remills pushed to gh-pages at bioboot/web-2015 ) )
. Lg Memory problem while performing anal...

Issue #276 commented on in Grantlab/bio3d
Barr an hour ago

Al Public

[ web-2015 Pushed to Grantlab/bio3d
-5 Merge branch 'master’ into feature...
Merge branch 'feature_aanma' of ...

2\ Subscribe to your news feed
Merge branch 'master” into feature...

PeaTlal it sinnie faned buoiimdatine tho i



https://github.com
https://bitbucket.org
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D www.bbc.com/news/technology-44351214
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Top Stories

Gangster 'Whitey' Bulger killed in
prison

Bulger was severely beaten by one or
more inmates shortly after arriving at the
prison, sources say.

® 30 October 2018

Synagogue shooting victims'
funerals start

® 30 October 2018

What do American voters care
about?

(® 30 October 2018



What is the big deal?

* At the simplest level GitHub and Bitbucket offer backup of
your projects history and a centralized mechanism for
sharing with others by putting your Git repo online.

e GitHub in particular is often referred to as the “nerds
FaceBook and LinkedIn combined”.

* At their core both services offer a new paradigm for open
collaborative project development, particularly for software.

* |n essence they allow anybody to contribute to any
public project and get acknowledgment.




First sign up for a GitHub account
https://github.com

GitHub

Build software
better, together.

Powerful collaboration, code review, and code management for
open source and private projects. Public projects are always free.



https://github.com

Pick the FREE plan!

Pull requests Issues Gist

Welcome to GitHub

You've taken your first step into a larger world, @biobootStudent.

Completed [[D Step 2:
Choose your plan

Set up a personal accour

Choose your personal plan
Each plan includes:

Plan Cost Private repositories

Unlimited collaborators

Large $50/month 50 Choose o ) o
Unlimited public repositories

Medium $22/month 20 Choose
Free setup

Small $12/month Choose HTTPS Protection

Email support
Micro $7/month Choose
Wikis, Issues, Pages, & more

$0/month Chosen

ade in US Dollars. Cor
e based on current exchange r

change as the

Don't worry, you can cancel or upgrade at any time




Your GitHub homepage

Check your email for verification request

Pull requests Issues Gist

Pro tip: updating your profile with your name, location, and a profile picture helps other
GitHub users get to know you.

Contributions E] Repositories 2\ Public activity

Contributions

biobootStudent

Joined on Aug 26, 2015

This is your contribution graph. When you make a commit to a repository, you’ll get a © for that
day. Make more contributions and you’ll get a darker green square. Over time, your chart might
start looking something like this.

We have a quick guide that will show you how to create your first repository. You’ll also make a
commit and earn your first green square!

Read the Hello World guide




Skip the hello-world tutorial

Pull requests Issues Gist

Your email was verified.

Learn Git and GitHub without any code!

biobootStudent ~ Your repositories

You don’t have any repositories yet!
Welcome to GitHub! What'’s next?

Create your first repository or learn more about
Create a repository

Git and GitHub.
Tell us about yourself

Browse interesting repositories
Follow @github on Twitter '
ProTip! Feline cephalopod adhesives are great
for decorating portable computation devices.
/ ProTip! Edit your feed by updating the users you follow and repositories you watch.

N\ Subscribe to your news feed



https://guides.github.com/activities/hello-world/

Name your repo
bimMm 143

rstudio_test/... kebabs pack... Institute of B... bioconducto... BIMM-143, L... Create a Ne...

."

O Search GitHub Pull requests Issues Marketplace Explore

Create a new repository

A repository contains all the files for your project, including the revision history.

Owner Repository name
"% bioboot~ { bimm143
Great repository names are short and memorable. Need inspiration? How about cuddly-invention.

Description (optional)

Public
Anyone can see this repository. You choose who can commit.

Private
You choose who can see and commit to this repository.

v Initialize this repository with a README
R EAD M E sBlts will let you immediately clone the repository to your computer. Skip this step if you're importing an existing repository.

Add .gitignore: None v Add a license: None~v | ()

Create




Copy the “Clone” HTTPS link

o This repository  Search Pull requests Issues Marketplace Explore

bioboot / bimm143 ® Unwatch ~
<> Code Issues 0 Pull requests 0 Projects 0 Insights Settings

No description, website, or topics provided.

Add topics

D 1 commit ¥ 1 branch © 0 releases 22 1 contributor

4
Branch: master v New pull request Create new file = Upload files = Find filé - &[] X6 LN 6FT0 Bd
<)

‘ \ bioboot Initial commit Clone with HTTPS @ Use SSH

£) README.md Initial commit Use Git or checkout with SVN using the web URL.

4
https://github.com/bioboot/bimm143.gi L@.
EE README.md K

Open in Desktop Download ZIP

bimm143




RStudio > New Project > Version Control

New Project

Create Project

New Directory
Start a project in a brand new working directory

Existing Directory
Associate a project with an existing working directory

Version Control
Checkout a project from a version control repository

Cancel




RStudio > New Project > Version Control

New Project

Back

| 1

G

Clone Git Repository

Repository URL: GitHub
https://github.com/bioboot/bimm143.git Paste

Project directory name:

bimm143_github

Create project as subdirectory of:

~/Desktop/courses/bimm143_S18 Browse...

v/ Open in new session Create Project Cancel

Y I DD G-I I STR ) S D)




Demo of editing, adding
committing and pushing

Check if new Git tab
Appears in RStudio?

Environment History Connections GED

B Diff M Commit L | &ey 6 Now experiment editing the
Staged Status Path README.md file in RStudio
@ B E .Jgitgnore and adding, committing and
@ BEE testRpro pushing changes to GitHub

via this tab




Demo of editing, adding
committing and pushing

Check if new Git tab
Appears in RStudio?

Environment History Connections GED

B Diff M Commit @ | ¥ - !
Staged Status Path

™ B B .gitignore

- B B test.Rproj

Now experiment editing the
README.md file in RStudio
and adding, committing and
pushing changes to GitHub
ERGIERE]

When you are ready copy your
different class directories/projects
to this new GitHub tracked folder



Side-note: How to edit online

Specifically lets add some Markdown content

‘ ’ This repository Pull requests Issues Gist D +~

biobootStudent / demo1_github @Unwatch~ 2  Star 0  YFork 0

:master v demo1_github / README = B

biobootStudent 1 nd Update README

{

9 lines (5 sloc) ©.236 kB Raw Blame History

# My first Git repo is now online
This is a first line of text.
This is a 2nd line of text.

I am going to use **markdown** syntax from now on because it is _cool!_
I am a student in [bioboot camp](http://bioboot.github.io/web-20815/)

Terms Privacy Security Contact Help tatus APl Training Shop Blog About Pricing




summary

e Gitis a popular ‘distributed’ version control
system that is lightweight and free

e GitHub and BitBucket are popular hosting
services for git repositories that have changed the
way people contribute to open source projects

* |ntroduced basic git and GitHub usage within
RStudio and encouraged you to adopt these ‘best
poractices’ for your future projects.



| earning Resources

Set up Git. If you will be using Git mostly or entirely via
GitHub, look at these how-tos.
< https://help.github.com/categories/bootcamp/ >

Getting Git Right. Excellent Bitbucket git tutorials
< https://www.atlassian.com/qit/ >

Pro Git. A complete, book-length guide and reference to Git,
by Scott Chacon and Ben Straub.
< http://git-scm.com/book/en/v2 >

StackOverflow. Excellent programming and developer Q&A.
< http://stackoverflow.com/questions/tagged/qit >



https://help.github.com/categories/bootcamp/
https://www.atlassian.com/git/
http://git-scm.com/book/en/v2
http://stackoverflow.com/questions/tagged/git

_earning git can be paintul!

However In practice it is not nearly as crazy-making as
the alternatives:

 Documents as emall attachments
e Hair-raising ZIP archives containing file salad
 Am | working with the most recent data?”

* Archaelogical "digs” on old email threads and
uncertainty about how/if certain changes have been
made or issues solved



Finally Please remember that GitHub

and BitBucket are PUBLIC and that

you should cultivate your professional
and scholarly profile with intention!




| Muddy Point Assessment |



https://goo.gl/forms/rq4jaE9OwOvvfMO63

Reference Slides



Side-Note: Changing your
default git text editor

e You can configure the defau

ne used when Git needs you
message.

> git config --global core.

t text editor that will
to type in a

editor nano

* |f not configured, Git uses your system’s default
editor, which is generally Vim.



Using Command Line Git

1. Initiate a Git repository,
2. EAit content (Le. change some files).
3. Store a ‘snapshot’ of the current file state.x



Initiate a Git repository



Initiate a Git repository

> cd ~/

Desktop

> mkdir git_class # Make a new directory
> cd git_class # Change to this directory
> git Init # Our first Git command!

> |s -a

# what happened?



Side-Note: The .git/ directory

Git created a ‘hidden’ .git/ directory inside your
current working directory.

You can use the ‘Is =a’ command to list (/.e. see)
this directory and its contents.

This is where Git stores all its goodies - this is Git!

You should not need to edit the contents of the .git
directory tor now but do feel free to poke around.



lmportant Git commands

> git status  # report on content changes

> git add <filename>  # stage/track a file
> git commit -m "message” # snapshot




lmportant Git commands
> git status  # report on content changes >

> git add <filename>  # stage/track a file
> git commit -m "message” # snapshot

You will use these three commands again and again in your Git workflow!



Git TRACKS your directory content

* TO get a report of changes (since last commit) use;
> git status

* You tell Git which files to track with:
> git add <filename>

This adds files to a so called STAGING AREA
(akin to a “shopping cart” before purchasing).

* You tell Git when to take an historical SNAPSHOT of
your staged files (/.e. record their current state) with:

> git commit -m ‘Your message about changes’




=

(2 O

Example Git workflow

—va creates a README text tile
(this starts as untracked)

Adds file to STAGING AREA*
(tracked and ready to take a snapshot)

Commit changes”
(records snapshot of staged files!)



Example Git workflow

Eva creates a README text file

Adds file to STAGING AREA*

Commit changes”®

N

Eva modifies README and adds a ToDo text file

@ Adds both to STAGING AREA*

Commit changes”®




1. Eva creates a README file

> # cd ~/Desktop/qgit_class
> # git init

> echo "This is a first line of text." > README
> git status # Report on changes

# On branchimaster
#
# Initial commit
#

Untracked files:
(use "git add <file>..." to include in what will be committed)

#
#
#
# README
#
#

nothing added to commit but untracked files present (use "git add" to track)



2. Adds to ‘staging area’

> gitadd README  # Add README file to staging area
> git status # Report on changes

# On branch master
#

# Initial commit

#i
#iChanges to be committed:
# (use "git rm --cached <file>..." to unstage)
#

# new file: README

#




3. Commit changes

> git commit -m “Create a README file” # Take snapshot
# [master (root-commit) 8676840] Create a README file

# 1 file changed, 1 insertion(+)
# create mode 100644 README

> git status # Report on changes

# On branch master
# nothing to commit, working directory clean



4. Eva modifies README file
and adds a ToDo file

> echo "This is a 2nd line of text." >> README
> echo "Learn git basics" >> ToDo

> git status # Report on changes
# On branch master
#

# Changes not staged for commit:
# (use "git add <file>..." to update what will be committed)
(use "git checkout -- <file>..." to discard changes in working directory)

modified:

#

#

#

#

# Untracked files:
# (use 'git add <file>..." to include in what will be committed)
#

#

#

#

no changes added to commit (use "git add" and/or "git commit -a")



5. Adds both files to ‘staging area’

> git add README ToDo # Add both files to ‘staging area’
> git status # Report on changes
# On branch master

# Changes to be committed:
# (use "git reset HEAD <file>..." to unstage)

modified: README
new file: ToDo

H H H



6. Commits changes

> git commit -m "Add ToDo and modify README"

# [master 7b679fa]l Add ToDo and modity README
# 2 files changed, 2 insertions(+)
# create mode 100644 ToDo

> git status

# On branch master
# nothing to commit, working directory clean



Example Git workflow

1. Eva creates a README text file

2 Adds file to STAGING AREA®

3. Commit changes*

Eva modifies README and adds a ToDo text file

4.
N
. @ Adds both to STAGING AREA*
o. Commit changes*

...But, how do we see the history of our project changes”



git log: Timeline history of
snapshots (/.e. commits)

> git log

# commit 7b679fa747e8640918fcaad7e4c3f9c70c87b170
# Author: Barry Grant <bjgrant@umich.edu>

# Date: Thu Jul 30 11:43:40 2015 -0400

#

# Add ToDo and finished README

#

# commit 867684016107 70ae32e2fd4face0/7d1d5¢c68619¢
# Author: Barry Grant <bjgrant@umich.edu>

# Date: Thu Jul 30 11:26:40 2015 -0400

#

# Create a README file

#



git log: Timeline history of
snapshots (/.e. commits)

> git log

# commit 7b679fa747e8640918fcaad7e4c3f9c70c87b170
# Author: Barry Grant <bjgrant@umich.edu>

# Date: Thu Jul 30 11:43:40 2015 -0400

#

# Add ToDo and finished README

#

# commit 86768401610770ae32e2fd4face07d10d5¢68619C ‘
# Author: Barry Grant <bjgrant@umich.edu>

# Date: Thu Jul 30 11:26:40 2015 -0400

#

# Create a README file
# Past




Side-Note: Git history is akin
to a grapn

Nodes are commits labeled by their
unique ‘commit ID’.

(This is a CHECKSUM of the commits
author, time, commit msg, commit content
and previous commit ID).

HEAD is a reference (or ‘pointer’) to the
currently checked out commit (typically the
most recent commit).

Time



Projects can have complicated
graphs due to branching

Master Feature

7:7_ - 39x2 @

| 5000. ..

3606

‘ Branches allow you to work independently

1g9K...

of other lines of development we will talk
more about these later!



You explicitly and iteratively te
track (“git add”) and snapsho

Key Points:

Git keeps an historical log “(git log”) of t

content c
G

It Is good practice to regularly ¢
of your working directory, stagl

nanges (and your comments on t

nanges) at each past commit.

(“git status”)

| git what files to
' (“git commit”).

e

EeSE

neck the status
Ng arena repo



Break



Summary of key Git commands:

> git status # Get a status report of changes since last commit

> git add <filename> # Tell Git which files to track/stage

> git commit -m ‘Your message’ # Take a content snapshot!

> git log # Review your commit history

> git diff <commit.ID> <commit.ID> # Inspect content differences

> git checkout <commit.ID> # Navigate through the commit history




Your 'Staging  Local
Directory  Area’” Repository

status -




git diff: Show changes
between commits

> git diff 8676 7b67

# diff --git a/README b/README
# Index 73bc85a..07bd82¢c 100644
# --- a/README

# +++ b/README

Q@@ -1 +12 @@

# This is a first line of text.
# +This is a 2nd line of text.
# diff --git a/ToDo b/ToDo

# new file mode 100644

# index 0000000..14fbd56
# --- /dev/null

# +++ b/ToDo

#Q@@ -0,0 +1 @@

# +Learn git basics




git diff: Show changes
between commits

> git diff 7b67 8676

# diff --git a/README b/README

# index 67bd82c¢..73bc85a 100644
# --- a/README

# +++ b/README

# Q@@ -1,2 +1 @@

# This is a first line of text.

#

# diff --git a/ToDo b/ToDo

# deleted file mode 100644
# index 14fbd56..0000000
# --- a/ToDo

# +++ /dev/null

# Q@@ 1 +0,0 @@

#




git diff: Show changes
between commits

> git diff 8676 ## Difference to current HEAD position!

# diff --git a/README b/README

# index 73bc85a..67bd82c 100644
# --- a/README

# +++ b/README m 7687 ...
#@Q@-1+1,2 @@

# This is a first line of text.
# +This is a 2nd line of text.

# diff --git a/ToDo b/ToDo
# new file mode 100644

# index 0000000..14fbd56
# --- /dev/null

# +++ b/ToDo

#Q@@ -0,0 +1 @@

# +Learn git basics




HEAD advances automatically with
each new commit

m 7.7- e To move HEAD (back or forward)

| on the Git graph (and retrieve the

associated snapshot content) we
can use the command:

> git checkout <commit.ID>

3676. ..



git checkout: Moves HEAD

> more README
This is a first line of text.
This is a 2nd line of text.

> git log --oneline
# 7b679fa Add ToDo and finished README
# 8676840 Create a README file

HEAD 2 108

3696. ..




git checkout: Moves HEAD
(e.g. back in time)

> more README
This is a first line of text.
This is a 2nd line of text.

> git log --oneline 7‘7_ N

# 7be79fa Add ToDo and finished README
# 86706840 Create a README file

> git checkout 86768
# You are in 'detached HEAD' state...<cut>...
# HEAD is now at 8676840... Create a README file

> more README
This is a first line of text.

> git log --oneline
# 8676840 Create a README file



git checkout: Moves HEAD
(e.g. back to the future!)

> git checkout master
# Previous HEAD position was 8676840... Create a README file

# Switched to branch 'master
'HEAD (" T4

> git log --oneline
# 7b679fa Add ToDo and finished README
# 8676840 Create a README file

> more README
This is a first line of text.
This is a 2nd line of text.

3696. ..



Side-Note: There are two™ main ways to
use git checkout

* Checking out a commit makes the entire working
directory match that commit. This can be used to
view an old state of your project.

> git checkout <commit.ID>

* Checking out a specific file lets you see an old
version of that particular file, leaving the rest of
your working directory untouched.

> git checkout <commit.ID> <filename>



You can discard revisions
with git revert

* The git revert command undoes a committed
snapshot.

* But, instead of removing the commit from the
project history, it figures out how to undo the
changes introduced by the commit and appends
a new commit with the resulting content.

> git revert <commit.ID>

* This prevents Git from losing history!



Removing untracked files
with git clean

* The git clean command removes untracked files from
your working directory.

e Like an ordinary rm command, git clean is not

undoable, so make sure you really want to delete the
untracked files betore you run it.

> git clean -n # dry run display of files to be ‘cleaned’

> git clean -t # remove untracked files



GUIs

Tower (Mac only)
GitHub_Desktop (Mac, Windows)
SourceTree (Mac, Windows)
SmartGit (Linux)
RStudio

https://git-scm.com/downloads/quis



https://git-scm.com/downloads/guis

